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Suporte técnico
Se você tiver dificuldades em usarRecordPad Software de Gravação de Som leia o tópico 
aplicável antes de solicitar suporte. Se o seu problema não estiver coberto neste manual do 
usuárioPor favor, veja o up-to-dateRecordPad Software de Gravação de Som Suporte técnico 
on-line emwww.nch.com.au/recordpad/pt/support.html.

Se isso não resolver seu problema, entre em contato conosco usando os contatos de suporte 
técnico listados nessa página.

Sugestões de Software
Se você tem alguma sugestão de melhorias paraRecordPad Software de Gravação de Som, 
ou sugestões para outros softwares relacionados que você possa precisar, por favor poste em 
nossa página de Sugestões emwww.nch.com.au. Muitos de nossos projetos de software 
foram realizados após sugestões de usuários como você. Você recebe um upgrade grátis se 
seguirmos sua sugestão.

www.nch.com.au/recordpad/pt/support.html
www.nch.com.au
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Sobre RecordPad Professional Sound Recorder
RecordPad é um aplicativo avançado de gravação de som.
Usando o Gravador de Som Profissional Do RecordPad você pode:
● Grave mensagens de voz ou anúncios.
● Use automaticamente um comprimento, nome e volume de arquivos pré-selecionados.
● Exportar arquivos para uma pasta local no formato wav, mp3, aiff e flac.
● Grave arquivos em segundo plano durante a execução de outros programas.
● Controle a gravação da linha de comando.
Requisitos do sistema
● Windows XP/Vista/7/8/10
● Pentium 300 or higher CPU
● 32MB or higher RAM
● Sound Card
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Controles de gravação
Abaixo estão os principais botões de função no RecordPad. Esses botões são todos 
mostrados por padrão, mas o menu Exibir pode ser usado para ocultar os botões que você 
não deseja ser mostrado.
Jogar (barra de espaço)
Toca a última gravação. 
Registro (F5)
Clique neste botão para iniciar uma nova gravação ou continuar uma gravação pausada.
Pausa (F6)
Clique nisso quando quiser pausar uma gravação e continuar depois. Para continuar gravando 
depois de pausar o arquivo, clique no botão gravar novamente.
Retake Recording (Home) 
Select this option to restart your current recording.
Stop/Save (F7)
Clique nisso para terminar e salvar sua gravação atual na lista de gravações.
Options (Ctrl+O) 
Click this to open the Options window. 
Gravações (Ctrl+L)
Clique neste botão para abrir a janela de gravações e navegue por, carregue ou modifique 
suas gravações. Para obter mais detalhes, consulte a seção Encontrar e Reproduzir gravações

Excluir(Ctrl+D)
Clique neste botão para excluir a última gravação feita. Depois de clicar nisso, o último arquivo 
gravado não aparecerá na janela de gravações. 
Comprar Online
Clique nisso para comprar uma licença de software e registro do RecordPad. Para obter mais 
detalhes, consulte o Software de Registro. 
Help (F1)  
To view the help documentation for RecordPad, click the Help menu and select Help Contents.

3

options.html
findandplay.html
register.html


Referência de campo hash
Os seguintes campos podem ser usados no formato de nome do arquivo. Observe que, para 
que todos os nomes de arquivos sejam únicos, você deve incluir %autonumber% ou %SS% no 
formato de nome do arquivo.
● %autonumber% - número de aumento automático
● %YYYY% - ano atual
● %MM% - mês atual
● %DD% - dia atual do mês
● %HH% - hora atual
● %MIN% - minuto atual
● %SS% - segundo atual
Nota:  que o formato do nome do arquivo não deve conter nenhuma outra sequência ou 
caracteres após %autonumber%.
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Opções de linha de comando
Você pode controlar facilmente o RecordPad a partir da linha de comando. O uso da linha de 
comando é o seguinte abaixo:
recordpad [command] [options] 
COMANDO: 
-gravar [formato] [configurações de formato]
Comece a gravar. O arquivo de saída será colocado na pasta de saída conforme definido nas 
configurações atuais. Se o "prompt for file name" estiver ativado, você será solicitado para um 
nome de arquivo antes do início da gravação; caso contrário, um nome de arquivo será 
gerado automaticamente com base nas configurações atuais.
Opções de formato:
● wav: gravar em formato wav
● mp3: registro no formato mp3
● aif/aiff: gravar em formato aiff
● flac: registro em formato flac
Opções de configurações de formato:
Se você não especificar cada uma das configurações de formato, o RecordPad usará as 
configurações de formato atuais para gravar o arquivo.
Arquivo wav: -s <sfreq>-m <nchans>-b <bitrate> </nchans> </sfreq>
onde:
● -s <sfreq>: frequência amostral do arquivo de saída (Hz)</sfreq>
● <nchans>-m: número de canais</nchans>
● -b <bitrate>: definir a bitrate em bits</bitrate>
Arquivo MP3 (Bitrate Encoding, codificação de bitrate) mp3: -cbr -b <bitrate>[-h] -m 
<mode>[-p]</mode> </bitrate>
onde:
● -b <bitrate>: definir a taxa de bits 8/16/24 etc.</bitrate>
● h: maior qualidade, mas um pouco mais lento
● -m <mode>: estéreo, (j)oint, (f)orce ou (m)ono (j padrão)</mode>
● -p: proteção contra erros
Arquivo Mp3 (Bitrate Encoding, codificação de bitrate) mp3: -vbr -b <minbitrate> 
<maxbitrate>-B -q <n>-m <mode>[-p]</mode> </n> </maxbitrate> </minbitrate>
onde:
● -b <minbitrate>: especificar bitrate mínimo permitido</minbitrate>
● -B <maxbitrate>: especificar a taxa máxima permitida</maxbitrate>
● -q <n>: configuração de qualidade para VBR. padrão n=4, 0 = alta qualidade, arquivos 

maiores. 9 = arquivos menores</n>
● -m <mode>: estéreo, (j)oint, (f)orce ou (m)ono (j padrão)</mode>
● -p: proteção contra erros
Arquivo Aiff: -s <sfreq>-m <nchans> </sfreq>
onde:
● -s <sfreq>: frequência amostral do arquivo de saída (Hz)</sfreq>
● <nchans>-m: número de canais</nchans>
Arquivo Flac: -s <sfreq>-m <nchans>-c <compression> </nchans> </sfreq>
onde:
● -s <sfreq>: frequência amostral do arquivo de saída (Hz)</sfreq>
● <nchans>-m: número de canais</nchans>
● -c <compression>: taxa de compressão de 0 a 8</compression>
-gravar <filepath>[configurações de formato]
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Comece a gravar para um arquivo específico. Consulte a seção acima sobre como definir as 
configurações do formato. 
-pausa
Pausa na gravação. 
-pare
Pare de gravar (se gravar) ou Stop playback (se estiver sendo reproduzido). 
-jogar
Gravação de corrente de reprodução (deve primeiro executar o comando -stop). 
-feito
Termine de gravar o arquivo atual. 
-reiniciar
Reinicie a gravação. 
-retomar
Retome a gravação depois de pausada. 
-outdir<dirpath>
Defina a pasta de saída para a qual o RecordPad exporta arquivos. 
-saída
Saída do RecordPad. 
Opções:  
-show
Mostre o RecordPad quando estiver em execução. Esta é a configuração padrão. 
-esconder
Ocultar o RecordPad quando estiver em execução. 
-exitifstop
Sair do RecordPad se a gravação for interrompida. 
-ms<milliseconds>
Salve o arquivo de gravação atual e saia do RecordPad automaticamente após um número 
especificado de milissegundos. 
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Atalhos de teclado
A lista a seguir mostra atalhos para as tarefas mais comuns usadas no RecordPad.
Janela Principal
● brincar espaço
● registro F5
● pausa F6
● Retake Recording Casa
● Stop & Mark Done F7
● Excluir a última gravação Ctrl+D
● Janela de gravações abertas Ctrl+L
● Access Program Options Ctrl+O
● Documentação de ajuda aberta F1 
● Bloco de registro de saída (desligar) Alt+F4 
Encontrar e Reproduzir Gravações
● brincar F9 
● Editar áudio Ctrl+E
● Salvar como Ctrl+S
● Enviar para e-mail agora Ctrl+N
● Gravar arquivos para CD-ROM Ctrl+B
● Compactar e fazer backup de arquivos Ctrl+G
● Converter formato de arquivo de som Ctrl+M
● Transcreva com escriba expresso Ctrl+T
● excluir Ctrl+Excluir
● Selecione Todos Ctrl+A
● renomear F2
● Update Now (Rescan para novas gravações) F5
● Fechar janela de encontrar e jogar Esc
jogador
● Jogar/Pausa espaço
● Vá para começar Casa
● Vá para o fim fim
● rebobinar Esquerda
● encaminhar Direita
● fechar Esc
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Opções
Open the Opções Dialog Box by using the menu File -> Options  .
● registro 
● saída 
● transmitir 
● Geral 
● Chaves-quentes 
● horário 
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Registrar software
Uma licença de software comprada e registro é necessário para usar o RecordPad após o 
término do período de teste.
Você deve ser capaz de testar todos os recursos do RecordPad durante o período de teste. 
Depois disso, você deve comprar uma licença de software (registro). Isso é mais fácil de fazer 
online em www.nch.com.au/recordpad/register
Depois de comprar e ativar sua licença Do RecordPad, digite o código de registro que você 
recebe em seu e-mail na janela Register RecordPad, encontrada no menu Arquivo. Digite seu 
Código de Registro do Bloco exatamente como ele aparece. Por favor, note que o código é 
sensível ao caso - se você inseri-lo incorretamente, o código de registro não será aceito. 
Recomendamos que você copie e cole o código na janela de registro.
Se seu código de registro não for aceito...
1. Verifique se você inseriu o código de registro exatamente como ele aparece no e-mail que 

foi enviado para você.
2. Se a licença foi comprada para uma versão mais antiga do RecordPad, você pode precisar 

comprar uma licença de atualização em www.nch.com.au/upgrade . 
Para mais informações, visite o link http://www.nch.com.au/support/reg.html . 

9

http://www.nch.com.au/recordpad/register/index.html
http://www.nch.com.au/upgrade/index.html
http://www.nch.com.au/support/reg.html


Google Authorization Process on Windows XP 
and Vista
Extra steps are required to give RecordPad authorization to upload to Google Drive and/or 
YouTube when running on Windows XP or Windows Vista: 
1. Click Authorize... in the {Authorization} Authorization dialog. 
2. In the web page that opens, sign in to your Google account, if required. 
3. Confirm that you authorize RecordPad to access the requested features. 
4. Copy the Authorization Code  provided by Google and paste it in the Authorization 

confirm dialog in RecordPad. 
5. Click Ready to confirm that authorization is complete. 
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Termos de licença de software
Nosso objetivo é de que cada usuário tenha uma experiência de sucesso com nosso software. 
Oferecemos a você sem a inserção de você aceitar nosso Acordo de Licença de Usuário Final 
(EULA).
ACORDO DE LICENÇA DE USUÁRIO FINAL DE SOFTWARE (EULA)
Esta EULA limita nossa responsabilidade e é regida por um acordo arbitral e um acordo de 
local. Por favor, leia abaixo como estes termos afetam seus direitos.
1. Os direitos autorais deste software e qualquer trabalho visual ou áudio distribuído com o 
software pertencem ao NCH Software e outros listados na caixa de sobre. Todos os direitos 
reservados. A instalação deste software e qualquer software empacotado com ou instalado 
demanda deste software, incluindo atalhos e pastas de menu inicial, é licenciada apenas de 
acordo com esses termos. Esses direitos autorais não se aplicam a nenhum trabalho criativo 
feito por você, o usuário.
2. Ao instalar, usar ou distribuir o software, você, em seu próprio nome e em nome de seu 
empregador ou principal, concorda com estes termos. Se você não concordar com nenhum 
desses termos, você não pode usar, copiar, transmitir, distribuir ou instalar este software - 
devolvê-lo ao local de compra dentro de 14 dias para receber um reembolso total.
3. Este software, e todos os arquivos, dados e materiais que acompanham são distribuídos 
"como está" e sem garantias de qualquer tipo, expressas ou implícitas, exceto conforme 
exigido por lei. Se você pretende confiar neste software para fins críticos, você deve testá-lo 
totalmente antes de usá-lo, instalar sistemas redundantes e assumir qualquer risco.
4. Não seremos responsáveis por qualquer perda decorrente do uso deste software, incluindo, 
mas não se limitando a qualquer perda especial, incidental ou consequente. Todo o recurso 
contra nós para todas as reivindicações está limitado a receber um reembolso total do valor 
que você pagou pelo software.
5. Você pode não usar este software em nenhuma circunstância em que haja qualquer risco 
de que a falha deste software possa resultar em uma lesão física ou perda de vidas. Você não 
pode usar este software se você não fazer backup regularmente do seu computador, ou não 
tiver software antivírus e firewall instalado no computador, ou manter dados confidenciais não 
criptografados em seu computador. Você concorda em indenizar-nos de quaisquer 
reivindicações relacionadas a tal uso.
6. Você pode copiar ou distribuir o arquivo de instalação deste software em seu formulário 
completo inalterado, mas você não pode, em nenhuma circunstância, distribuir qualquer 
código de registro de software para qualquer um de nossos programas sem permissão por 
escrito. Caso você distribua um código de registro de software, você estará sujeito a pagar o 
preço total de compra por cada local onde ocorre o uso não autorizado.
7. O uso de dados coletados pelo software está sujeito à Declaração de Privacidade de 
Software NCH que permite a coleta automática de estatísticas de uso anonimizada em 
circunstâncias limitadas.
8. Escolha do Direito. Se você reside nos Estados Unidos, seu relacionamento é com a NCH 
Software, Inc, uma empresa dos Estados Unidos, e este acordo é regido pelas leis e tribunais 
do Colorado. Se você reside em qualquer lugar do mundo fora dos Estados Unidos, seu 
relacionamento é com a NCH Software Pty Ltd, uma empresa australiana, e este acordo é 
regido pelas leis e tribunais do Território da Capital Australiana. Tais tribunais têm jurisdição 
contínua e exclusiva sobre qualquer disputa entre você e nós, independentemente da 
natureza da disputa.
9. Somente clientes dos EUA: Acordo de arbitragem e renúncia de ação coletiva: LEIA ISSO 
COM ATENÇÃO. ISSO PODE AFETAR SEUS DIREITOS.
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Se você reside nos Estados Unidos, a NCH Software e concorda em arbitrar todas as disputas 
e reclamações entre nós. Este acordo para arbitrar pretende ser amplamente interpretado. As 
referências ao "NCH" "você" e "nós" incluem nossas respectivas subsidiárias, afiliadas, 
agentes, funcionários, antecessores em interesse, sucessores e designas. Este acordo de 
arbitragem não o impede de trazer questões à atenção das agências federais, estaduais ou 
locais dos EUA. Tais agências podem, se a lei permitir, pedir ajuda contra nós em seu nome. 
Este Acordo evidencia uma transação no comércio interestadual e, portanto, a Lei Federal de 
Arbitragem rege a interpretação e a aplicação desta disposição. Esta disposição arbitral 
sobreviverá à rescisão deste Acordo.
Uma parte que pretende buscar arbitragem deve primeiro enviar para o outro, por correio 
certificado, um Aviso de Disputa escrito ("Aviso"). O Aviso à NCH deve ser endereçado a:
Departamento Jurídico
NCH Software, Inc.
6120 Greenwood Plaza Blvd, Ste 120
Greenwood Village CO, 80111
EUA
("Endereço de Aviso"). O Edital deve (a) descrever a natureza e a base da reivindicação ou 
disputa; e (b) estabeleceu o alívio específico procurado ("Demanda"). Se a NCH e você não 
chegara a um acordo para resolver a reclamação dentro de 30 dias após o recebimento do 
Aviso, você ou NCH poderão iniciar um processo arbitral. O valor de qualquer oferta de 
liquidação feita pela NCH ou você não será divulgado ao árbitro.
R. A arbitragem será regida pelas Regras de Arbitragem Comercial e pelos Procedimentos 
Complementares para Disputas Relacionadas ao Consumidor (coletivamente, "Regras AAA") 
da Associação Americana de Arbitragem ("AAA"), conforme modificado por este Contrato, e 
será administrado pela AAA. As Regras da AAA estão disponíveis online na adr.org, ligando 
para a AAA pelo telefone 1-800-778-7879, ou escrevendo para o Endereço de Aviso. O árbitro 
está vinculado aos termos deste Acordo. Todas as questões são para que o árbitro decida, 
incluindo questões relacionadas ao escopo e à aplicabilidade da disposição arbitral. A menos 
que a NCH e você concordem o contrário, qualquer audiência de arbitragem ocorrerá em 
Greenwood Village Colorado. Se sua reivindicação for de US$ 10.000 ou menos, 
concordamos que você pode escolher se a arbitragem será conduzida exclusivamente com 
base em documentos submetidos ao árbitro, através de uma audiência telefônica, ou por uma 
audiência presencial, conforme estabelecido pelas Regras da AAA. Se sua reivindicação 
exceder $10.000, o direito a uma audiência será determinado pelas Regras da AAA. 
Independentemente da forma como a arbitragem é conduzida, o árbitro emitirá uma decisão 
escrita fundamentada. A NCH pagará todas as taxas de arquivamento, administração e custas 
de arbitragem para qualquer arbitragem iniciada de acordo com os requisitos de aviso prévio 
acima. Se, no entanto, o árbitro constatar que a substância de sua reivindicação ou o alívio 
solicitado na Demanda é frívola ou trazida para um propósito inadequado, então o pagamento 
de todas essas taxas será regido pelas Regras da AAA. Nesse caso, você concorda em 
reembolsar a NCH por todas as verbas anteriormente desembolsadas por ela que são de 
outra forma sua obrigação de pagar as Regras da AAA. Além disso, se você iniciar uma 
arbitragem na qual você busca mais de US $ 75.000 em indenizações, o pagamento dessas 
taxas será regido pelas regras da AAA.
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B. O árbitro pode conceder auxílio declaratório ou cautelar apenas em favor da parte individual 
que busca alívio e apenas na medida necessária para fornecer alívio garantido pela 
reivindicação individual dessa parte. VOCÊ E NCH CONCORDAM QUE CADA UM PODE 
apresentar reclamações contra o outro somente EM SUA CAPACIDADE INDIVIDUAL, e NÃO 
COMO UM REQUERENTE OU MEMBRO DE CLASSE EM QUALQUER SUPOSTA CLASSE 
OU PROCESSO REPRESENTATIVO. Além disso, a menos que você e NCH concordem o 
contrário, o árbitro não pode consolidar mais do que as reivindicações de uma pessoa, e pode 
não presidir qualquer forma de representante ou processo de classe. Se esta disposição 
específica for considerada inexequível, então a totalidade desta disposição arbitral será nula e 
sem efeito.
C. Não obstante qualquer disposição neste Acordo em contrário, concordamos que se a NCH 
fizer qualquer mudança futura nesta disposição de arbitragem (além de uma mudança no 
Endereço de Aviso) você pode rejeitar qualquer mudança enviando-nos aviso por escrito 
dentro de 30 dias após a mudança para o Endereço de Aviso de Arbitragem fornecido acima. 
Ao rejeitar qualquer mudança futura, você concorda que vai arbitrar qualquer disputa entre 
nós de acordo com a linguagem desta disposição.
D. Para optar por sair deste Acordo arbitral e renúncia de ação coletiva envie um aviso de Opt 
Out (Recusa) ao Endereço de Aviso afirmando "Estou optando por sair do Acordo arbitral e da 
renúncia de ação coletiva contida nos Termos Legais aplicáveis à minha compra de um 
produto NCH ." Seu Aviso de Exclusão deve incluir a data e o comprovante de compra. O 
Edital Opt Out deve ser divulgado até trinta (30) dias após a data de compra. Um Aviso de Opt 
Out separado deve ser enviado para cada produto comprado.
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Geral - Encontrar e reproduzir gravações
Encontrar e reproduzir gravações
Abra a caixa de diálogo Encontrar e Reproduzir gravações a partir do item do menu Find & 
Play ou pressionando o botão Find & Play Toolbar. 
Todas as gravações na pasta de gravação especificada serão listadas.
Reproduzindo uma gravação
To play a recording select it and press F9. When the Play Control Box opens you can move 
back and forward within the recording using the left and right arrow keys. To pause playback 
press the spacebar. To stop and go to the beginning press Esc. To move to the beginning 
press Home. To move to the end press End. To go back to the list of recordings press Enter. 

Salvar como
Isso salvará a gravação selecionada para uma posição diferente em uma pasta local ou em 
rede.
Para salvar o arquivo gravado no disco rígido, selecione a gravação e clique no botão 
"Salvar". Digite o nome do arquivo e clique em OK. 
Excluindo uma gravação
Para excluir gravações, selecione-as e clique no botão Excluir. Você pode selecionar mais de 
uma gravação segurando a tecla Shift durante a seleção. 

Envie uma gravação
Esta opção permitirá que você envie uma gravação por e-mail. 

Faça upload de uma gravação
Essa opção permitirá que você carregue suas gravações para diferentes serviços de nuvem, 
incluindo Google Drive, One Drive e Dropbox. 

Editar áudio
Isso abrirá a gravação selecionada no WavePad: Um editor de som profissional completo para 
Windows. Ao editar arquivos de áudio, você pode cortar, copiar e colar partes das gravações 
e, se necessário, adicionar efeitos como eco, amplificação e redução de ruído. WavePad 
funciona como um editor de wav ou editor mp3, mas também suporta uma série de outros 
formatos de arquivo, incluindo vox, gsm, áudio real, au, aif, flac, ogg e muito mais. 

WavePad foi projetado para ser muito fácil e intuitivo de usar para edição de áudio. Em 
poucos minutos você poderá abrir ou gravar um arquivo e editá-lo. Mas se você tiver tempo 
para explorar os outros recursos, você encontrará muitas ferramentas poderosas para editar 
áudio projetado com o engenheiro de som profissional em mente. WavePad vem em duas 
versões uma versão básica gratuita e uma edição masters, ambas com um período de teste 
completo. 

Converter arquivo de som
Converte os arquivos de áudio em um formato diferente usando o Switch. O conversor de 
arquivos de áudio do Switch é muito fácil de usar. Com os arquivos selecionados adicionados 
ao Switch, selecione o formato que deseja usar e clique no botão converter. O Switch suporta 
a conversão para wav (PCM, ADPCM+, aLaw+, uLaw+, e outros), mp3, au, aif/aiff, gsm, vox, 
raw, ogg, flac, .rss, .amr+ e muito mais. 

transcrever
Permita o ditado simples e fácil dos arquivos usando o Express Scribe. Este aplicativo 
transcritor de computador apresenta reprodução de onda de velocidade variável, operação do 
pedal do pé, gerenciamento de arquivos e muito mais. 

Gravar para CD-ROM
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Os arquivos selecionados serão importados para o Express Burn. O Express Burn também é o 
programa de gravação de CD/DVD mais rápido do mundo usando sistemas de otimização 
proprietários. Ele também criará um arquivo de índice que começará a queimar imediatamente 
para um CD de dados. 
Guia de pastas
Por padrão, o Find and Play lista apenas gravações na pasta de registro local.
Você pode alterar a pasta padrão para segurar seus arquivos de áudio ou pode alterar a pasta 
alternativa para atender às suas necessidades. 
Se você quiser reproduzir arquivos sobre sua rede local, instale este programa no outro 
computador e aponte-o para a pasta que a Janela De Encontrar e Reproduzir está fazendo 
referência. 
Exibir guia do filtro
A guia Ver filtro permite pesquisar e filtrar o que é exibido na exibição da lista.
Você pode pesquisar ou filtrar o que é mostrado pelo texto em cada coluna, pela duração do 
áudio ou pela data da gravação. 
Speech Search Tab
On the 'Speech Search' tab you can choose to search for keywords in the recordings. You 
must select an installed Speech Recognition engine (eg. Dragon Naturally Speaking, IBM Via 
Voice). Microsoft supplies a free 'Speech Command and Control' engine (filename actcnc.exe) 
and this can be located using an internet search engine. Please note any speech engine used 
must support Context Free Grammars. You can also optionally select a trained speaker for the 
engine. 

If multiple times are found on your speech search clicking on the file will provide a list of the 
"key found at" times. Speech searching places a bookmark to hold the place in the audio when 
multiple times are found so you can jump to the keyword. 
Guia de opções de jogo
Defina o dispositivo de som que você usa para reproduzir seu arquivo de áudio, também 
defina 'Variable Speed Slow' e 'Variable Speed Fast' para variar a velocidade de reprodução. 
Clicar em 'Atualizar agora (Rescan para novas gravações) adicionará ou removerá 
quaisquer gravações que tenham sido feitas ou excluídas desde a última atualização.
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Opções - Opções ~ Recorde
Gravação
Dispositivo de registro
Se você tiver mais de uma placa de som instalada, use esta lista para selecionar a placa que 
deseja usar para gravação.
Canal de Entrada
Use esta lista de puxar para baixo para selecionar o canal de entrada para gravação. A 
configuração recomendada é "Microfone" ou "Mic-In". Se você tiver problemas ao usar a 
configuração do mic-in, selecione o Windows Record Mixer e abra o Mixer de gravação do 
Windows para ajustar manualmente as configurações.
Volume de registro
Ajuste o volume de gravação usando este fader. Quando o nível estiver definido corretamente, 
a exibição de nível na Janela Principal apenas tocará no vermelho ao gravar.
Se você tiver selecionado o Windows Record Mixer, você pode clicar no botão "Open 
Windows Record Mixer" para configurações manuais de mixagem.
Nível de ativação de voz
Isso controla a gravação ativada por voz. As configurações padrão são -18dB. Se a gravação 
começar muito cedo, aumente a configuração para até -10dB para reduzir a sensibilidade. Se 
a gravação não começar ou as palavras forem cortadas no final, reduza o nível para -20dB 
para aumentar a sensibilidade. Um controle deslizante aparecerá na janela principal quando 
esse recurso estiver ativado. Com este controle, você pode ajustar o nível antes de começar a 
gravar e visualizar quando o áudio que está sendo gravado acionará a ativação da voz. Você 
também pode ativar e desativar esse recurso clicando com o botão direito do mouse no 
medidor de volume na janela principal. Nota: Você deve ajustar primeiro o Nível de Volume de 
Registro. Os problemas de ativação de voz são muitas vezes devido a configurações 
incorretas de nível de registro.
Desnuda esta opção se você não quiser usar gravação ativação de voz.
Pausar o Bloco de Registro após segundos
Quando o Nível de Ativação de Voz estiver ativado, você pode especificar quantos segundos 
esperar antes que o RecordPad entre em status de espera.
Criar novo arquivo quando o tempo limite ocorrer
Quando o RecordPad é pausado quando o tempo acima for atingido, se essa opção for 
verificada, o arquivo atual será salvo e um novo arquivo será iniciado. 
Tempo máximo de gravação
Ativar verificação
Habilite esta opção se você quiser colocar um limite no comprimento que uma gravação pode 
alcançar.
Você pode selecionar o comprimento máximo na janela para a direita.
O tempo chegou.
Selecione "parar de gravar" para apenas fechar e salvar sua gravação quando o tempo 
máximo de gravação tiver sido atingido.
Selecione "criar nova gravação e continuar" para gerar uma nova gravação quando a primeira 
gravação estiver concluída.
Inicie a janela de gravações quando parar de gravar
Verifique esta caixa para exibir o diálogo Encontrar e Reproduzir gravações toda vez que 
parar de gravar, onde todas as gravações estão listadas e mais opções para trabalhar com o 
arquivo são exibidas. Consulte o tópico Encontrar e Reproduzir Gravações para obter mais 
informações sobre o diálogo.
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Opções - Opções ~ Saída
Formato de saída
Use o menu Formato de saída para selecionar o formato de arquivo em que deseja salvar um 
registro (wav, mp3, aif ou flac).
Você pode ajustar o nível de compressão ou o bitrate para o arquivo clicando no botão 
"configurações de formato". Observe que se você não estiver familiarizado com diferentes 
formatos de wav e mp3, você pode querer deixar o RecordPad nas configurações padrão do 
formato de arquivo.
RecordPad sempre grava arquivos AIFF em taxa de amostra de 44100 Hz e modo estéreo. 
Em seguida, você pode usar o Conversor de Áudio Switch (que pode ser baixado a partir de 
nch.com.au/switch) para converter para as configurações de formato desejadas que você 
deseja.
Pasta de Destino
Esta opção permite selecionar a pasta para a qual o RecordPad exporta arquivos. Para usar 
essa opção, digite a pasta onde deseja salvar arquivos do RecordPad ou use o botão de 
navegação à direita para localizar a pasta.
Nome do arquivo de saída
Selecione a opção "Solicitar o nome do arquivo antes de iniciar a gravação" se você quiser 
selecionar um nome diferente para cada arquivo gravado. 
Clique em "Exibir amostra" para exibir um nome de arquivo de amostra usando as 
configurações atuais. 
Selecione o "use este formato de nome de arquivo" quando quiser definir o nome do arquivo 
antes de começar a gravar. Consulte a seção Hash Field Reference para obter mais 
informações sobre nomes automáticos de arquivos. 
Clique em "Redefinir o número automático para 0" para redefinir o número automático para 0. 
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Opções - Opções ~ Transmitir
Enviar gravações por e-mail
Se essa opção for selecionada, o RecordPad enviará todas as gravações para o endereço de 
e-mail especificado como um anexo a um e-mail. Isso pode ser útil se você quiser ouvir 
gravações remotamente.
Por padrão, o RecordPad usa o MAPI para enviar e-mails usando seu software de e-mail 
MAPI (por exemplo, Outlook, Eudora, etc.). Verifique se sua versão do software de e-mail 
suporta MAPI e defina-a como o cliente MAPI padrão.
Se você tiver problemas com o MAPI, o RecordPad também pode enviar e-mails diretamente 
usando o servidor SMTP do seu ISP. Abra "Configurações de envio de e-mail" e selecione a 
opção "Use SMTP para enviar e-mail diretamente para o servidor" e digite o nome do servidor 
SMTP do seu ISP (por exemplo, smtp.yourisp.com).
Para obter mais informações, consulte Problemas de envio de e-mails usando MAPI e SMTP. 
Carregar gravações via internet usando FTP
Se você tiver um servidor FTP ou um site (com acesso ftp), selecione esta opção para fazer o 
RecordPad carregar todas as gravações para o seu servidor. Isso pode ser útil para fins de 
backup ou para disponibilizar as gravações na internet (públicas ou privadas, dependendo da 
configuração do servidor FTP).
Você deve inserir o servidor ftp (por exemplo, ftp.yourdomain.com), seu nome de usuário, 
senha e a pasta completa exata em que você deseja que os arquivos carregados (por 
exemplo, /home/yoursite/www/recordings).
Se você tiver algum problema com a configuração FTP, recomendamos fortemente que você 
tente fazer login manualmente com o software FTP (por exemplo, WS_FTP, CuteFTP) para 
verificar duas vezes você tem o caminho completo correto para a pasta de upload.
Para obter mais informações, consulte Problemas ao se conectar a um servidor FTP. 
Espelhar todas as gravações para esta pasta
Se você tiver uma unidade de backup ou quiser fazer backup de todas as gravações na rede, 
você pode usar essa opção. Observe que as gravações só são transferidas após a gravação e 
a compressão estiver completa.
Run external .exe  
Esta é uma opção avançada para permitir que os profissionais de TI adicionem outros 
recursos de transmissão ao RecordPad. Por exemplo, usar um codec proprietário ou inserir o 
arquivo em um banco de dados.
If this option is ticked, after RecordPad has completed recording the file, it will run the specified 
.exe program. The program is usually a command-line program. The name of the file can be 
sent as an argument using %s which RecordPad replaces with the full path to the file. 
Remember to include the full path to your .exe (enclose it in "") and to enclose the %s in 
inverted commas too. An example might be "C:\Program Files\MyProgram\myexe" -myoptions 
"%s".
Solicitando
Na seção Solicitar, você pode selecionar se as gravações são enviadas automaticamente 
após a conclusão ou se você gostaria de gravarpad para verificar se você gostaria de enviar a 
gravação primeiro.
Outros
Não envie quando o comprimento for igual ou inferior a (segundos)
Para evitar o envio de gravações curtas que não sejam autilizáveis, digite um comprimento de 
corte em segundos na caixa de edição.
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Opções - Opções ~ Geral
Tom
Com essas opções você pode optar por ter uma reprodução de tom quando o RecordPad 
começa ou pára.
Clique na caixa superior para reproduzir um tom quando a gravação começar, e a caixa do 
meio para reproduzir um tom quando parar.
Em alguns ambientes você é obrigado a reproduzir um tom durante a gravação. Para fazer 
isso, marque a caixa "Som de gravação de tom cada (segundos)" e digite o número de 
segundos entre os tons na caixa de edição.
Startup
Execute o RecordPad quando o computador é iniciado
Clique nesta caixa para ter o RecordPad aberto automaticamente quando o computador for 
iniciado.
Comece a gravar automaticamente quando o RecordPad for executado
Clique nesta caixa para que o RecordPad comece a gravar automaticamente sempre que for 
executado.
Aviso de espaço de disco baixo
Aviso quando o espaço do disco rígido estiver baixo (abaixo de MB)
O RecordPad avisará quando o espaço do disco rígido estiver acabando. Digite um número no 
campo de edição, em megabytes, quando você quiser ser notificado do espaço em disco 
baixo.
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Opções - Opções ~ Hot-Keys
Para abrir as configurações de teclas quentes em todo o sistema, use o menu Opções -> 
Hot-Key.
Quando você está trabalhando com o RecordPad aberto em primeiro plano, você pode 
controlar a gravação usando os botões de gravação padrão. 
You can also assign hot-keys that can be used to control recording while you are working in 
other application with RecordPad in the background. To do this, use the Hot-Keys tab of 
Options. Click Add, press the key that you want to use (including Alt or Ctrl if required) then 
select the command.
Para alterar uma tecla quente existente, selecione a tecla quente e clique em "Alterar...". 
Para excluir uma tecla quente existente, selecione a tecla quente e clique em "Excluir...". 
Nota: Atribuições de chaves quentes substituem as atribuições de chave padrão.
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Opções - Opções ~ Programação
Para agendar gravações antes do tempo, você pode usar o recurso de programação do 
RecordPad.
Você pode ver a lista de gravações programadas escolhendo a guia Agenda abaixo de 
Opções.
Para adicionar uma gravação agendada, basta clicar no botão Adicionar... Em seguida, você 
pode selecionar um dos tipos de horários disponíveis, incluindo Uma vez, Diárioou Semanal.
Para um cronograma único, você também precisará selecionar as datas de início e término. 
Você precisará selecionar o horário de início e término da gravação programada. Gravações 
diárias ocorrerão todos os dias da semana no horário especificado, e gravações semanais 
serão agendadas nos dias selecionados na parte inferior da janela.
Você também pode usar a caixa de seleção Active na parte superior da caixa de diálogo para 
ativar e desativar as gravações programadas sempre que você fizer ou não precisar delas.
As gravações programadas também podem ser modificadas selecionando-as na lista e 
clicando no botão Editar...
Para registrar quando o usuário estiver logado, você pode usar o Registro mesmo que o 
usuário não esteja logado na  opção. Depois de verificar a caixa, o RecordPad solicitará uma 
diálogo para inserir os detalhes da sua conta. Os detalhes serão usados para executar o 
RecordPad. Observe que ativar essa opção resultará em sua gravação ocorrendo em 
segundo plano. Portanto, uma vez habilitada esta opção, você não poderá interagir com o 
RecordPad.
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Referências de tela - Áudio de backup
A caixa de diálogo "Backup Audio" pode ser usada para fazer uma cópia de backup de uma 
gravação de áudio para um CD gravável ou uma unidade ou pasta selecionada.
Nota: Outros dados associados ao áudio não serão ressarcidos com o áudio. 
Compacte e copie arquivos selecionados para
Selecione onde fazer backup do áudio: 

● CD (usando Express Burn)
O áudio compactado será gravado em um CD, como arquivos de dados, usando o 
Express Burn. Se o Express Burn ainda não estiver instalado em sua máquina, ele será 
automaticamente baixado e instalado para você. 

● Uma rede compartilhada ou pasta local
O arquivo de áudio comprimido será copiado para a unidade ou pasta selecionada. 

Compressão de áudio
Selecione o formato do arquivo e o codec para comprimir o áudio. 
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Referências de tela - Resolução personalizada
Esta caixa de diálogo permite configurar a resolução do seu vídeo durante a salvação. Para 
definir uma resolução personalizada, clique no botão Salvar na barra de ferramentas e 
selecione o Disco: Faça disco de dados, computador/dados, dispositivo portátil, sequência de 
imagem ou opções 3D estereoscópicas. No menu Desistência de Resolução, selecione 
Personalizado.
Na caixa de diálogo Resolução Personalizada que abre, insira a largura e a altura em pixels e 
clique em OK.
Se a caixa de seleção manter a proporção estiver disponível, você pode verificar se ela deve 
manter a mesma proporção ao alterar a largura ou a altura. 
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Referências de tela - Taxa de quadros 
personalizado
Esta caixa de diálogo permite configurar a taxa de quadros (número de quadros por segundo) 
para o seu vídeo. Para definir uma taxa de quadros personalizada, clique no botão Salvar na 
barra de ferramentas e selecione qualquer uma das opções Disc, Computer/Data, Portable 
Device ou Stereoscopic 3D. No menu de queda da taxa de quadros, selecione Personalizado.
Na caixa de diálogo Taxa de quadros personalizado que abre, insira a taxa de quadros e 
clique em OK.
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Referências de tela - Formato detectado
This dialog shows you the detected format of the video sequence during the saving process. 
To detect the format of your video, click the Export Video button on the Home tab bar and 
select either of the following options: Video File, 3D Video File, Portable Video, Lossless 
Video, Blu-ray Movie Disc, Blu-ray Data Disc, DVD Movie Disc, DVD Data Disc, Image 
Sequence, YouTube, Flickr, Dropbox, Google Drive, OneDrive, or Vimeo.
Clique no botão Detectar ao lado do campo Predefinição. Detecte ajustará o formato de 
resolução de saída de vídeo com base no tamanho da tela do monitor.
Se você quiser usar um formato diferente, você pode selecionar o formato da lista de 
drop-down predefinido.
Clique em OK para usar o formato selecionado como formato de saída.
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